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Getting Set up on ADS to Use Smith Chart Utility

Open up Latest verion of Keysight Advanced Design System (ADS)
Create a New Workspace

Give Workspace a name and location off folder

Click Create Workspace

Advanced Design Systen{ 2025 Update 1

Hwn e

Advanced Design System 2025 Update 1 (Main)
. ; . : ; : ; ; a1 New Workspace
File View Options Tools Window DesignKits DesignGuid W s e S hhcain onm e o
p M >
Qew L Workspace... Name: LudwigFig3-14
pen 4 jl \ i! Libra ry... Create in:  C:\Users\jaguirre2\OneDrive - San Diego State University (SDSU.EDU)
Close Workspace T . _
- I v Schematic.. (v) Show advanced
M Delete Workspace... E Layout..
These are the current workspace settings:
Ao | s
r“{‘l Save All [ Sym bol... * Workspace path: C:\Users\jaguirre2\OneDrive - San Diego State University (SDSU.EDU)\LudwigFig3-14

¢ Library Name: LudwigFig3-14_lib

W lAco All 'k Notebook... ‘ * Included Libraries: ADS Analog/RF, ADS DSP Q\ Change Libraries...
Create Workspace Cancel Help

Related topics
What is a workspace?
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Getting Set up on ADS to Use Smith Chart Utility

1. Create a Schematic Cell (click on schematic icon)
2. Name the Cell
3. Click on Create Schematic

Wi lBF BBE>E=S

File View Folder Vies

Library View

[w] C\Users\jagtirre2\OneDrive - San Diego State Univer.

W
m_@.' New Schematic

Create a new schematic in the specified cell.

Library: LudwigFig3-14_lib
Cell: RCckt

~

(/) Show advanced

Usage Hierarchy Create Schematic Cancel Help

1
=
)

= Related topics

C:\Users\jaguirre2\OneDrive - San Diego State University (SDSU
i ?
E O seacn E S E 0 What is a cell?
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Getting Set up on ADS to Use Smith Chart Utility

1. Rtclick Tool Bar area

2. Select Parts

3. In Parts menu select Basic Components
4. Place Capacitor and Resistor and ground

[t RCckt [LudwigFig3-14_lib:RCckt:schematic] [EDITING] (Schematic):1

— a X

Command Quick Help - Select

File Edit Select View Insert Options Tools Layout Simulate Window Dynamiclink DesignGuide Hel

Differences From Layout

NEHR XYY 60 LR\ 2R ZLIRE 2@ o

Layers

MMl RS =FEHEIW H - E#E S BREERG

Parts 8 x Message List - O errors, 0 warnings

_ avigator
© i .
~ LParts

Search all libraries r S
. Properties

Basic Components |T[ l . ‘ l l Search
All Palettes R
Basic Components 3
Lumped-Components it R'] . : . Basic
Lumped-With Artwork v Basic Editin
Sources-Controlled R=50 Ohm- 9
Sources-Freq Domain DC Annotation
Sources-Modulated
Sources-Noise ¥ HSD
Sources-Time Domain 7|

: : nsert
Simulation-DC
Simulation-AC ' S v Instance Commands
Simulation-S_Param
Simulation-HB Select / Deselect
Simulation-LSSP S :
Simulation-XDB v Simulation
Simulation-Envelope \/
Simulation-Transient Zoom
Simulation-Batch
Simulation-Load Pull
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Getting Set up on ADS to Use Smith Chart Utility

1.

2.

3.

4.
Parts g X
D i
Search all libraries Y

‘Basic Components m .

Basic Components
Simulation-S_Param
Lumped-Components
Simulation-AC

All Palettes

Basic Components
Lumped-Components
Lumped-With Artwork
Sources-Controlled
Sources-Freq Domain
Sources-Modulated
Sources-Noise
Sources-Time Domain
Simulation-DC
Simulation-AC
Simulation-S_Param
Simulation-HB
Simulation-LSSP

Select the Simulation S_Param Palette in the Parts Menu
Select and Place TermG Source

Change Resistor resistance to Variable 50/g
Insert Var: Variable equation for ‘g’

Parts g X
O iy
Search all libraries k i
Simulation-S_Param v
@ @

5P 5P Lab

T W

FrmSwp

Options

EI

Term  RefNet

=1 VAR

MEMORY  Plle Y
'@ Pin 'E' '@F- MEE MLE v

wir L= [T ANl At

Insert VAR: Variable Equation

Using this icon enables you to easily place a VAR item
(Variables and Equations component) on your designs.

Note: A schematic can include any number of VAR
items.
A VAR item can define multiple variables or equations.

VAR’
— VAR
- g=1.0

TermG —C R

TermG1 - d G w R1

Num=1 >~ c=1.0pF 2 R=50/gOh

Z=50 Ohm . T o -
L
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Getting Set up on ADS to Use Smith Chart Utility

1. Insert S-parameter Simulation (500 MHz to 4 GHz)
2. Insert Prm Swp

Parts g X
D iy , o~ =
searchallibraries [ (R | &¥5| S-PARAMETERS /| PARAMETER SWEEP

e | VAR
- = VAR1 : — R — A e e
3 7 S_Param ParamSweep
QSlmulatlon-S_Param ¥ . - .g=10 - - - sp1 O o - O .

Sweep2

¥@ & ' -  Start=500MHz =~ ' ~ SweepVar="g" '
P 5P Lab : : - Stop=4 GHz - : . - . SimInstanceName[1]="SP1"

T , o ~ Step=10.0 MHz , ~_SimInstanceName|[2]=
Flan | Prm Swp — . . Sim”‘.STa‘nCeNameB]?
—f— ermG C R SimInstanceName[4]=
' % TermG1 = - \L c1 R1 '~ SimiInstanceName[5]=
Options | Termf 1S [Num=1 . . . . ~~ C=1.0pF R=50/g0hm - - gimiInstanceName[6]=
I}]E o Z=50 Ohm = T S .. . . . . Start=.1. .

Term  RefNet R L . Stop=1

- Step=
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Getting Set up on ADS to Use Smith Chart Utility

1. Double click S-PARAMETERS box Q\

2. Set start, stop, step parameters as shown e "‘T“JVVS'PARA”ETE“S | o] TR
3. Double click Parameter Sweep box e s,

4. Enter parameter to sweep, start, stop and step-size as shown sea-ioa sdar:
5. Click simulations tab @L;“? 1 B o Elsm onm EEEEEE%

6. Enter Simulations to perform (SP1) SoEaRp s

7.

Run Simulation o bar

— . B3 Para weep 55 N }P(—
L ParamSweep Instance Name i I PPN el

[ S_Param Instance Name karamowespilnstance Name Sweep2

| sp1L Sweep2 - -
| Sweep Simulations Display “

Frequency Parameters  Noise  Output ¢ P Sweep  Simulations  Display
Simulations to perform
Simulation 1 SP1 ¢ ( )

Parameter to sweep g

Parameter sweep

Frequency SwespiTyoe
Sweep Type
© Start/Stop C Simulation 2
© start/Stop O

Start | Simulation 3
Start 500

Sto 1 i i
Stop 4 R Simulation 4

Step-size 0.1 ; i
Step-size 10.0 P Simulation 5
Num. of pts. 351 Num. of pts. |10 Simulation 6
[} Use sweep plan [ Use sweep plan

OK Apply Cancel Help oK Apply Cancel Help
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Admittance Response of Parallel RC Circuit at
constant conductances

b o] seramreRs | [ Pevaverersweee | 1. Open New Data Display Window>New Data Display
VAR S paran Porsmovesp 2. Select Smith Chart
S SimlrstanceyamelijersP1* 3. Select Dataset and Add to Traces
Step=10.0 MHz SimInstanceName[2]=

SiminstanceName[3]=

- 1ermG C R simInstanceName[4]=
TermG1 c1 R1 SiminstanceName[5]=

Num=1 C=1.0 pF R=50/g Ohm SiminstanceName[6]=
Z=50 Ohm Start=1
Stop=1
AE Step=

1 Data Display/Untitled 3 [page 1]:3 dlot Type Plot Options Plot Title

dlate Windo DynamicLink  DesignGuid

File Edit View |Insert Marker History Options Tools Page Wir
BEH

] {@ Open Another Schematic Window [V [Tl ica B X W ™ O B - @ G @ @ EEE @
B Layout i @) DD E R (][« [q] ] [»] M

csY {} Symbol Palette g X ,
RCckt v Trace Options...

7] Close k S — - \_
ARA v New Data Display @ @‘7‘@ ;req s
==

Datasets and Equations Traces

— ,
~— H Open Data Display... R
PortName(1) >>Add Vs..>>

Open Thermal Viewer... PortZ

_ BH=
— < Delete <<
MHz = Simulation Status @i BamZ(Y e

S

\ & S
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Admittance Response of Parallel RC Circuit at
constant conductances g=.1 2> 1

Fig 3-14(Ludwig)

i 0 P P
s i r&F‘ S-PARAMETERS r&-Rd/ PARAMETER SWEEP
VAR
\gj—A‘lRlTJ S_Param ParamSweep
= SP1 Sweep2
Start=500 MHz SweepVar="g"
Stop=4 GHz SimInstanceName[1]="SP1"
Step=10.0 MHz SimiInstanceName[2]=
A SimlInstanceName[3]=

R SimlInstanceName[4]=

R1 SimInstanceName[5]=

R=50/g Ohm SimiInstanceName[6]=
Start=.1

TermG + G
‘2 | TermG1 &l
> | Num=1 =2 C=10PE
Z=50 Ohm
Stop=1

—._— Step=

(

short open
.F=500 MHz g=01

g #

S(1,1)

freq (500.0 MHz to 4.000 GHz)
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Admittance Response of Parallel RL Circuit at

Constant Conductances g=.1 2 1

Fig 3-13 (Ludwig)

— W3 | S-PARAMETERS
VAR S_Param
VART SP1
g=1 Start=500 MHz
Stop=4.0 GHz
Step=10 MHz
+
Term L R
Term1 § L1 R1
Num=1 L=10 nH R=50/g Ohm
Z=50 Ohm R=0

| fWe/| PARAMETER SWEEP

ParamSweep

Sweep1
SweepVar="g"
SimInstanceName[1]="SP1"
SimInstanceName[2]=
SimInstanceName[3]=
SiminstanceName[4]=
SimlInstanceName[5]=
SimInstanceName[6]=
Start=.1

Stop=1

Step=

F=500 MHz

— short

s(1

open

freq (500.0 MHz to 4.000 GHz)
PDSU



Admittance Response of Series RL Circuit at
Constant Conductances g=.1 2 1

Fig 3-15 (Ludwig)

F=500 MHz
[E] VAR @5 | S-PARAMETERS %Y/ PARAMETER SWEEP I vl o
en] R : N
r=1.0 S_Param ParamSweep r=0.1
SP1 Sweep1 0.
Start=500 MHZ SweepVar="r"
Stop=4 GHz SimlnstanceName[1]="SP1"
Step=10 MHz SimInstanceName[2]=
SimInstanceName[3]=
SimInstanceName[4]=
SimInstanceName[5]=
e SiminstanceName[6]= —short
+1‘ TermG = L R Start=.1 \‘_-.:
TermG1 L1 R2 Stop=1 %)
Num=1 _ R=(r*50) Ohm Step=.1
z=50 ohm  Lb=10nH

freq (500.0 MHz to 4.000 GHz)
| J U



Admittance Response of Series RC Circuit at
Constant Conductances g=.1 2 1

Fig 3-16 (Ludwig)

gﬁ;, S-PARAMETERS
va| VAR -
VAR1 S_Param
r=1.0 SP1
= 2 ©  Start=500 MHz
Stop=4 GHz
Step=10 MHz
) |
R
: (0]
TermG R1
R=(r*50) Ohm

2 | TermG1 C1
Num=1 C=1.0 pF
Z=50 Ohm

r‘%’ PARAMETER SWEEP

ParamSweep

Sweep1

SweepVar="r" z
SimlInstanceName[1]="SP1"
SiminstanceName[2]=
SimInstanceName[3]=

SimlInstanceName[4]= — short

SiminstanceNamel[5]= i open
SimInstanceName[6]= o

Start=.1

Stop=1

Step=0.1 F=500 MHz

freq (500.0 MHz to 4.000 GHz)
SDSU
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Smith Chart to design T-type network to match
base-emitter input impedance of bipolar transistor

Match frequency = 2 GHz
Simulate from 500 MHz to 4 GHz
Transistor circuit as shown

T R
T-type C1 R1
. ~ C=1.91pF R=31.250Oh
50 ohm characteristic line impedance matchlng B P "
network -

)
Zin=50 Transistor

| ve

SDSU SDSU




Smith Chart to design T-type network to match
base-emitter input impedance of bipolar transistor

3. From Basic components palette create Transistor circuit
4. Place 50 Ohm Source

5
R1
R=31.25 Ohm

Z=50 Ohm

® T
+* 1ermg1 , , lm o
Q\- AU - > C=1.91pF
Num=1

\ At 2 GHz

7 20.0000 +j -15.0000

e 0.03200 +j 0.02400

SDSU SDSU




Smith Chart to design T-type network to match
base-emitter input impedance of bipolar transistor.....

1. Go to Schematic Tools Menu Tt |
Select Smith Chart Dﬂ '—U EI i%f :
Enter Frequency 10 1l & €3

. Parts g X
Unnormalize chart ® i
Click on palette icon Smith chart component to populate schematic ———

Click on source icon, enter value (50 +j(0)) ohm

Simulation-S_Param

. Click on load icon, enter value (20 +j(-15)) ohm @
T SerDes Toolkit » o Q//>
[EDITING] * (Schematic):1 /

Options  Tools GENESYS Synthesis... GE & Lf_lu @@:Eg: lk "é’ ,Q{ 4%
. T SPECTRASYS...

NV A WN

Freq (GHz) Z0 (Ohms) Current Schematic SmartCompenent
. 2 50 i transistormatch [LudwigFig3-18 T _nt

Encode Designs... sl [LudwigFlg 18 T
IC-CAP Import

LineCalc

Define Source/Load Network Terminations...

Network Response

Power Electronics Tools

v v v v

Quantum Tools

z= Controlled Impedance Line Designer

0 e '_..
=2 u= .59 = = 4.0e9 : e \
Network Schematic

JE Via Designer = —
= | Lock Source Impedance ") Lock Load Impedance —
Smith Chart...
Gamma: 0.46852 < -141.340 | Z: 20.0000 +j -15.0000 Delete Selected Component

Impedance Matching...
Model Composer b VSWR: 2.76309 Y: 0.03200  +j 0.02400  Zo: Value: 204*15

<

HSPICE Compatibility Component 4

: Build ADS Circuit Auto 2-Element Match Reset Close Rt -
— Netlist Export 4

SDSU SDSU



Smith Chart to design T-type network to match
base-emitter input impedance of bipolar transistor

N

. Select Smith Chart Smart Component
3. Connect to your design
4. Select this component as the SmartComponent in the Smith Chart Utility

Smith Chart Utility

TERH& t X9 $aPP O‘%% R

Current Schematic SmartComponent

‘? % E ® W¢. Iﬁ‘ Edit  View Circles Help
[==]
~ .' e - —”E?[ﬁ& @eoe k«m@&jj}(
MRS FIEE B H S #E S BR-EiBRG B e
Parts F X eq (GHz) Z0 (Ohms)
£ 50 ormalize

O i DA_SmithChartMatch_transistormatch
earch all libraries T DA_SmithChartMatch1 Define Source/Load Network Terminations...

Smith Chart Metching,_ > = R

v i TermG c R1
TermG1 C1 i
L > Gi191pF < R31250mm
Z 50 Ohm

SDSU

transistormatch [LudwigFig3-18_T_nt ~ i ‘

K DA_SmithChartMatchl |

SDSU



Smith Chart to design T-type network to match base-
emitter input impedance of bipolar transistor

1. In the Smith Chart Utility Lock source and load impedance
2. Select matching components from Palette
3. Note a manual movement of input impedance on Smith chart

Freq (GHz) Z0 (Ohms) Cu
2 50 (] Normalize  tr:

Define Source/Load Network Terminations...

1.56225 ol

.
O

S

7 L./ Source
S/ *'\/ : )
. \ \

o AR b ”. ,;'-.;—f-"'
PN s
i( Fln g 10

O [ e o s Dl

ock Source Impedance Lock Load Impedance

SDSU SDSU



Smith Chart to design T-type network to match base-
emitter input impedance of bipolar transistor

In Smith Chart Utility

1. Add inductor graphically on Smith Chart

2. Add capacitor graphically on Smith Chart

3. Add inductor graphically to complete T-match
4. Build ADS Circuit
On Schematic

5. In schematic select (left cli ith Chart component
6. push into Smart com ponen 0"s'ere,,,,c,i,,,r,,gg>it

w8 ¢ e \ % @ N |
< )' — L 15
-4. @ 5@ — VAR NAME 'C III oo e Hum) 1.=3.950486 nH

L

L2

1L=4.319637 nH
R=1e-12 Ohm
g e ot

o R=1e-12 Ohm
RM\ | ] sl AMl

DA_SmithChartMatch1_transistormatch
DA_SmithChartMatch1

R
TermG
- R
Li’r:'f R=31.25 Ohm
7=50 Ohm

e

e

1
C=2.400476 pF

1.02303 e 0.01992 +
Q/V Build ADS Circuit Auto 2-Element Ma
2, 40045 pf h
a3 as
T
]
AN L 24pF
4.32 nF S, LN T
V. A 8.2
/) A Y o
10§ J\ X N —r—"—f.'p‘ 10
AN s '
A = 5 -
<> D A——— —
P2 5 T\ e —— | i
Num= 0 N —,
- R el
o, ':\\;\\ "y, LE
N \
\t‘“ - | 3.95 nF
Q T— - 0 o Load
O Saurce




Smith Chart to design T-type network to match base-emitter

Datasets and Equations

List v

input impedance of bipolar transistor R
Search
1. Insert Frequency sweep controller and
: f
2. Simulate Help req
. . e PortName
3. Select Window>New Data Display = = ﬁ & e @ lI[']II ‘ | PortName(1)
4. Select S11 dataset and Add — PortZ
5. Select Smith Chart plot type pey 7 PortZ(1)
Layout Simulate Window S
DA ST TS 5 opan Anther Schamaticw san ()
. - @ o : :E Layout m2
! R {> Symbol
TermG ‘*' . @ . l C R1
TermG1  [* £l R=31.25 Ohm e
Num=1 ’ .
Z=50 Ohm A New Data Display
o = _ _ ,w Open Data Display... m
Fé:;? S-PARAMETERS , , , Onen Thermal Viewer

- . S_.Pafam
' - SP1
‘ © ©  Start=500 MHz

- Stop=4 GHz
Step=10 MHz

freq (500.0 MHz to 4.000 GHz)

>>Add >>

>>Add Vs..>>

<< Delete <<

m1
freq=500.0 MHz

S(1,1)=0.264 / 134.759
impedance = Z0 * (0.645 +j0.260)

m2
freq=4.000 GHz

$(1,1)=0.995/ 64.514
impedance = Z0 * (0.009 +j1.584)

Palette

N

&

E=
=

1234
5678

& E

SDSU SDSU
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Smith Chart to design T-type network to match base-emitter
input impedance of bipolar transistor

Plot rectangular return loss

1. Select rectangular format
2. Select S(11) Dataset

3. Select dB handling of data

=== B Datasets and Equations Traces 0
[ji#%Fq DS i
L/ E transistormatch v Tre |
T T o @ Complex Data:4 < -
"@" '.& @ € Search = Compiex bad _
=i -10—
Palette g freq You are adding complex data to a plot a
that only supports scalar data. _
% '“‘I’ PortName = i
- PortName(1) How would you like to handle this data? :-
@ @ Parte O dB <\© @, _20__
PortZ(1) a8) -
() dBm =
= ) i
(== E > 11 (O Magnitude i
( >)\ O Phase -Boi
@& ) Real part _
\ g Q (O Imaginary part ]
ffZJTEmedomainsignaI -40 LN A L I O B
/‘> D 0.5 1.0 1.5 2.0 25 3.0 3.5 4.0
i
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Smith Chart Utility for LNA Company Provided S-

pPara meter file (from measurement on test board, assumed deembedded)

[ 2-Port S-parameter

Instance Name
S2P Instance Name
SNPL

File Interpolation Parameters Display

3. Find S2P data component ol
4. Place in schematic
5. Browse for LNA S2P file e

Edit...

Network parameter filename

Copy template...

Data files list...

Parts [ 4

File Type
Touchstone
@ iii ! Block Name

Browse.

Check/View S-Parameters

<2

oK Annly Cancel

v % & v A = EE634_Keysight Projects > ADS 5 AnalogDevices > hmcB410Ip2fe sparameters

Heln

Part Search

52p ¥

Organize ~  New folder

Il
2 = g

SNP1 ,
2-Port S-parameter File I File= RN _
EE674_Cadence Projects B HMCB410LP2FE
52 P Con n Sz P JoshTranMSThesis HMCB410LP2FE_Sparameters.s2p 471172025 9:14 AM S2P File:
2-Port S-parameter File Library: ads_datacmps Keysight
Microsoft Copilot Chat Files
S2 P_ Eq n MyWorkspace2_wikds
—_— : 2* Por‘t Sfpa ?’ameter F||e > Signal Integrity-20241021T1848222-001
= Cadence-20241021T184601Z-001
Message List - 0 error s
O 0 Press F1 for more he'p_ File name: | HMCE410LP2FE_Sparameters.s2p
Open Cancel
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Smith Chart Utility for LNA Company Provided S-

pPara meter file (from measurement on test board, assumed deembedded)

N Y

1. Draw schematic as shown
2. Run Simulation
3. Graph Dataset S11

O

|§“§| S-PARAMETERS |

A S2p
Start=1.0 GHz SNP1
File="C:\Users\jaguirre2\OneDri

Stop=6. GHz ve - San Diego Stal

Step=10 MHz

Terrnz 7 24 Tem
Num=2 Term1
Num=1
Z=500h
= ity 2-50 Ohm

s(1,1)

s(1,1)

m1

freq=4.000 GHz

$(1,1)=0.122/ 32.062
|mpedance Z0*(1.219 +j0.161)

10— |dB(S(1,1))=-18.258

©°

S (m2
freq=4.000 GHz

€ = e
\Ti“}\ g i T~ =
= P * ~J
25 A~ i
/
Z =60.65+*8.05at4GHz | |
86-—b \ \

freq (1.000 GHz to 6.000 GHz)

I I I I I I I
10 15 20 25 30 35 40 45 50 55 60
freq, GHz
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Smith Chart Utility for LNA Company Provided S-

pPara meter file (from measurement on test board, assumed deembedded)

Tools > Smith Chart ,
Unnormalize

Set Load impedance (Zin to LNA)
Set source impedance (50 ohm)

.

TING] * (Schemati Memory Interface

) -4
~— Gy BROX I a ! ! .
ons  Tools SerDes Toolkit Q= [ﬁ] Lgﬂ @ Baos k il H X X f S B2
S : . /
%' (4 GENESYS Synthesi Freq (GHz) Z0 (Ohms) Current Schematic SmartComponent y \
o Y | ") Normalize ~ LNAschematic [LNAv1 lib:LNAschemz \\>' &,

4 50

gk [ SPECTRASYS... | \
: 1§\i Define Source/Load Network Termyj A -
Encode Designs... e Network Response e EYYTT
W ¢ IC-CAP Import | i =\ OSavres
ek LineCalc [ -
Start=1 2 A
Stop=6. Power Electronics
Step=1(

Quantum Tools

Network Schematic

5 led | de . =
Control {Rese Lock Source Impedance | Lock Load Impedance — T
s besigher | Gamma: 012274 < 32199 Z 610000 + 810000 Delete Selscted Component Set Defaults...
Smith Chart...
VSWR: 1.27983 e 0.01611  +j -0.00214 Zo: Value: 61+j*8.1 Loss:

Build ADS Circuit Auto 2-Element Match Reset \t\@




Smith Chart Utility for LNA Company Provided S-

pPara meter file (from measurement on test board, assumed deembedded)

5. Connect transmission line to load
6. Note new Zin on Smith Chart

)
Network Schematic

Source T Load

- R 50 ohm Txline
148 deg length

Zo: 50.0 Value: 147.733 Dea

SDSU




Smith Chart Utility for LNA Company Provided S-parameter file
(from measurement on test board, assumed deembedded)

1. Add open stub from Palette to Network Schematic
2. Build ADS Circuit

Palette : I“ “ IL Circles Help -
— = Network Schematic
[g E] | 50 ohm stub
15 deg length FieEEE
o 3“ _ - - ze s Source Load
ST .
i %
:} g: T } ) Network Schem::ié
g Y 148 deg Iength 23.2637 4 ) 24.9721 = igsogm -:-Xllnfh
T | eg len
2.79256 Y: 0.01997 + -0.02144  Zo: 50.0 ;14 ... 8 g
VRN
Build ADS Circuit /U Auto 2-Element Match Reset Close
: TETIEET Y - - q
SDSU SDSU




Smith Chart Utility for LNA Company Provided S-parameter file

(from measurement on test board, assumed deembedded)

Insert Smith Chart Smart
Component

Push into Smart component
to see circuit

Run S-parameter simulation
Graph S11 in Smith and
rectangular format

w

?th@;

TLIN TLIN P2
P1
Num=1

L1 TLZ Num=2
Z=50 Ohm Z£=50 Ohm

-

E=14.95 E=147.7
F=4GHz F=4GHz

Parts g X
fr(eq ;1 000 GHz ™z
iiw 5(1,1)=0.060/ 27.996 -
@ iy - impedance = 0 * (1.111 +0.063) |
_ [P | B
Search all libraries Y  Paan R 4 ?n‘j 2 as e
i sP1 = V2= V‘I = ) %
Starf=1.0 GH = (= 5 20 y 5\
. . Serbs ot @ S g™ ’ ‘m2,/
Smith Chart Matching v Steg=10 MHz 25 / o
File="C:\Users\jaguirre2\OneDrive - San Diego State \
U

Nz
m;a

‘@. 10 15 20 25 30 35 40 45 50 5 6.0
i _LUNAschemati Term1 freq, GHz
0 DA Smthh lM h Num=1
| 2Z=50 Ohm
Al = freq (1.000 GHz to 6.000 GHz)
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Smith Chart Utility for LNA Company Provided S-parameter file

(from measurement on test board, assumed deembedded)

[ ] - .
Compare LNA S-parameters Analog provided S-parameters
for S11 with matched case
m1 AL
(@] searaverers | g%q#gofzg%z 062 i < ol
r‘fr impedance = 20 * (1.219 +]0.161) - L’S?Eé‘ﬂ?ﬁf’gésa B
épq- > S2P ,J_Tﬂ = g s __47
Start=1.0 GHz SNP1 = Y = m2
Stop=6. GHz File="C:\Users\jaguirre2\OneDrive - San Diego Sta = j E 2 | e
Step=10 MHz @ = 2 ™ =1 o
T ] - | ]
= e
Num=2 & EC
=50 Ohm e o
i = - S R ) FR FR SR B N —
- 1.0 1.5 2.0 25 3.0 35 40 45 5.0 55 6.0
— freq, GHz

freq (1.000 GHz to 6.000 GHz)

#TH 5 1
S-PARAMETERS — 0
" 5_Param freq=4.000 GHz il — -
51 S(1,1)=0.060/27.096 T egeacogonz |
Start=1.0 GH Impedance = 111 +j0. 3
Stop=6,GHz P ( L ) Ao —aB(Sh 1 24:368 s
Step=10 MHz . "{_nil 2 e ) L
= “) A : ) / T
SNP1 w S = ,/ \mZ-"/
File="C:\Users\jaguirre2\OneDrive - San Die N e / v
=R 4
. ik /
S lerm -30— LI 1
L?Jrnnfz JA_SmithChartMatchfl Term1 Vil
Z-50 Ohm DA_SmithChartMatch| Num=1 3 T T T T T T T T T
Z=50 Ohm 1.0 1.5 20 25 30 35 40 45 5.0 55 6,
freq, GHz

freq (1.000 GHz to 6.000 GHz)
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The End
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